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HOL: Building Solutions using Microsoft Office InfoPath 
2003 
This lab will help turn you into a knowledgeable developer of InfoPath 2003 form solutions.  
The lab begins with creating and using simple forms, continues through adding business 
logic and second data secondary data sources, eventually demonstrating programming 
using ADO.NET datasets, task panes, managed code and more. Throughout, you will learn 
how InfoPath 2003 enables developers to rapidly build rich, robust forms that capture 
industry-standard XML data. 

Objectives 
After completing this lab, you will be able to: 

• Design and deploy InfoPath 2003 forms using the built-in InfoPath set of controls 
• Learn how to add rules and conditional formatting to InfoPath forms 
• Learn how to work with data connections and off-line submit logic 
• Learn advanced InfoPath form features, including using managed code, task panes and digital 

signatures 
 

Modules 
This lab includes 4 stand-alone modules.  You may choose to do any of them in any order: 

1. Creating and Deploying InfoPath 2003 Forms  Page 4 
(Estimated completion time: 30 minutes) 

2. Customizing InfoPath Solutions with Business Logic and User Roles  Page 30 
(Estimated completion time: 30 minutes) 

3. Working with XML Data and Custom Submit Processing  Page 47 
(Estimated completion time: 30 minutes) 

4. Managed Code, Task Panes, Modifying Schemas, Digital Signatures Page 65 
(Estimated completion time: 30 minutes) 

Startup Notes 
 

Userid:  LuisB 
Password:  abc.123 

 
For the best experience, it is recommended that you maximize the Virtual PC window 
and used the lab manual that is available from the desktop inside the Virtual PC image.  To 
toggle the Virtual PC between the maximized (full screen mode) and restored state, press 
the RIGHT ALT and ENTER keys together.  Try this a few times before beginning.  At the 
end of this lab, you should return the Virtual PC to the restored window state. 
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Module 1: Creating and Deploying InfoPath 2003 Forms  
This module provides an introduction to working with InfoPath 2003 forms. First, you will 
experience InfoPath 2003 as an end user. You will add data to an InfoPath 2003 form and 
work with existing forms to merge and export XML data to Excel 2003. Next, you will create 
a new form of your own containing both standard and advanced controls. Finally, you will 
find out about the options available for deploying your InfoPath 2003 solution. 

Estimated time to complete this module: 30 minutes 

Objectives 
After completing this module, you will be able to: 

• Fill out an InfoPath 2003 form, including digitally signing data in a form.  
• Merge form data from multiple forms.  
• Export data to an Excel 2003 worksheet.  
• Design and preview a simple form.  
• Publish a form to a form library.  
• Distribute a form using an e-mail program.  
• Disable design mode for a form. 
• Add advanced controls (the file attachment control, the master/detail control, the choice control, and 

the filter control) to your InfoPath 2003 forms. 

Exercises 
 
• Edit Data in an InfoPath 2003 Form 

• Merge and Export XML Data with InfoPath 2003 

• Design an InfoPath 2003 Form 

• Deploy a Form from InfoPath 2003 

• Work with Advanced Controls in InfoPath 2003 

 
The sample files for this module may be found in the C:\Microsoft Hands-On-Lab\HOL-
BPR21\Source\Exercises folder.   
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Exercise 1: Edit Data in an InfoPath 2003 Form 
In this exercise, you will take a tour of InfoPath 2003 from a user’s perspective. Using an 
existing form, you will enter new data. In addition to filling in text fields, you will “sign” one 
section of the form using a digital certificate. 

Open the Sample Form 
• Start InfoPath 2003 by navigating to Start | All Programs | Microsoft Office | 

Microsoft Office InfoPath 2003.  

• Under Open a form in the Fill Out a Form dialog box, click Open.  

• In the Open dialog box, browse to C:\Microsoft Hands-On-Lab\HOL-
BRP21\Source\Exercises.  

• Select LabBPR21-01.xsn. 

• Click Open. The FabriKam sales report form opens in InfoPath 2003. Once you 
have opened the form, you can begin filling it out.  

Fill Out the Form 
• In the Sales Representative field, type your name. 

• Press TAB to move to the next field.  

• In the Period drop-down list, select January 2004. 

• Press TAB. 

• In the E-mail Address text box, type “yourname@fabrikam.com”. 

• Press TAB. 

• In the Department drop-down list, select Consumer Health Care. 

• Press TAB. You move to the Customer section of the form. 

• In the Customer Name field, type “Contoso Corporation”.  

• Press TAB. You move to the Items section of the form. 

• In the Name text box, type “Product A”. 

• Press TAB. 

• In the Price text box, type “5”. 

• Press TAB. 

• In the Units Sold text box, type “2”.  

• Press TAB. InfoPath 2003 fills in the Total box for you.  

• Click the Insert item label directly underneath the table.  
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• In the Name text box, type “Product B”. 

• Press TAB. 

• In the Price text box, type “12”. 

• Press TAB. 

• In the Units Sold text box, type “8”.  

• Press TAB. 

• Click Click here to insert notes.  

• Type “New customer”. 

Insert an Additional Customer Section 
When you move your pointer over certain controls in a form, such as repeating sections or 
optional sections, a shortcut menu button appears in the upper-left corner of the control. If 
you click this button, you can gain access to menu commands that let you work with the 
controls. In this step, you use this button to add an additional customer section to the form.  

• Move your pointer over the Customer Name label. 

• Click the shortcut menu button that appears immediately to the left of the label. The 
customer section of the form now looks like Figure 1. 

 
Figure 1. The shortcut menus provide both general and section-specific actions. 

• On the shortcut menu, click Insert customer above. An empty customer section 
appears directly above the one you just filled out.  

• Press CTRL+Z to undo the new customer section. 

Save the Form 
• Select File | Save. 

• Browse to C:\Microsoft Hands-On-Lab\HOL-BRP21\Source\Exercises\LabWork. 

• Type “InWork” in the File name text box. 

Notes 
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• Click Save. 

Digitally Sign Part of the Form  
When filling out a form, you can add a digital signature to part or all of the form, depending 
on the form’s design. You can digitally sign forms only if they are designed to accept digital 
signatures. You can also remove or review digital signatures. Once signed, the signed form 
or part of the form that is signed cannot be altered without invalidating the signature. 

• Place your cursor on the Customer Name field of the order. 

• Click the Click here to sign this section command at the bottom of the form. The 
Digital Signature Wizard opens.  

• In the Select the certificate that you want to use to sign the form list, select the 
Luis Bonifaz certificate. 

• Click Next.  

• In the Comment box, type “I’m signing the Customer section”. 

• Click Finish.  

• Closely review what you are signing, including the image of the form content, the 
comment, and the information associated with the signature, and then select the I 
have verified this content before signing check box.  

• Click Sign.  

• Click Close. 

• Move your cursor over the fields in the customer name section. Because you 
digitally signed this portion of the form, a digital signature icon appears in the upper 
right corner of each field in the section as shown in Figure 2. 

 
Figure 2. The icon to the left of the product name is the digital signature icon. 

• Move your cursor to Sales Representative. The digital signature icon does not 
appear here or on the other fields in the order’s header, because only the Customer 
section was signed. 

• Select File | Close. 

• Click No to close the form without saving it. 

Notes 
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Exercise 2: Merge and Export XML Data with InfoPath 2003 
Up to this point in the module, you haven’t seen any tags or other indications that the data 
you are entering is stored in an XML format. But InfoPath 2003 data is just that. InfoPath 
2003 uses the XML standards to make passing data between forms or between 
applications transparent. In this exercise, you try out two features that move data around: 
merging an XML document into an existing form, and exporting a form’s data to Excel 
2003. 

Open a Sample XML Document in Notepad 
• Navigate to Start | All Programs | Accessories | Notepad. 

• Select File | Open. 

• In the Open dialog box, browse to C:\Microsoft Hands-On-Lab\HOL-
BRP21\Source\Exercises. 

• In the Files of type drop down list, choose All Files. 

• Select LabBPR21-02.xml. 

• Take a moment to look at the XML document’s structure and data. The document 
includes order header information like Sales Representative, one Customer node, 
and several items ordered by that customer. 

• Select File | Exit. 

Open Your Saved Form 
• In InfoPath 2003, select File | Open. 

• In the Open dialog box, select InWork.xml. 

• Click Open. 

Merge Forms into Your Form 
• Select File | Merge Forms.  

• In the Merge Forms dialog box, browse to C:\Microsoft Hands-On-Lab\HOL-
BPR21\Source\Exercises. 

• Select LabBPR21-02.xml.  

• Click Merge. 

• A new customer and that customer’s ordered items are added to the form, but 
notice that the Sales Representative and other header fields were not overwritten. 

Export Data to Excel 
If you want to analyze data from one or more forms in an Excel 2003 worksheet, you can 
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use the Export to Excel feature in InfoPath 2003. You can export data from one form at a 
time or from several forms at once. In this exercise, you export data from a single form. 

• Select File | Export To | Microsoft Office Excel.  

• On the first page of the Export to Excel Wizard, click Next.  

• On the second page of the wizard, select Form fields and this table or list.  

• Because you want to analyze sales data, click items in the list. The Export to Excel 
Wizard looks like Figure 3. 

 
Figure 3. The items section contains the information on products sold. 

• Click Finish. Excel 2003 opens to a new workbook. 

Note: To further customize export options, or to export data from multiple forms, you could 
click Next instead of Finish and follow the remaining steps in the wizard.  

• Take a few moments to review the resulting worksheet.  

• Close Excel 2003 without saving the worksheet. 

• In InfoPath 2003, select File | Close. 

• Click No to close the form without saving it. 

Notes 
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Exercise 3: Design an InfoPath 2003 Form 
In this exercise, you learn how to create a new InfoPath 2003 form, add controls, and add a 
color scheme. You also learn how to select print settings and preview the form. 

The form you create in this exercise is for the fictional company FabriKam. Each month, 
sales representatives from FabriKam go to various countries or regions around the world to 
sell FabriKam products to customers. At the end of each month, FabriKam’s management 
team wishes to receive a form listing all of the sales in a given country or region. 

Create a Blank Form 
• In the Fill Out a Form dialog box, click Design a Form.  

• In the Design a Form task pane, click New Blank Form.  

Insert a Title  
After creating your form, you can insert a title that describes the form's purpose. 

• In the Design Tasks task pane, click Layout.  

• In the Insert layout tables list in the Layout task pane, click Table with Title.  

• In the form, click the Click to add a title placeholder text. 

• Type FabriKam Sales Report.  

• Select the title text. 

• On the Formatting toolbar, click Bold. Now that you have added a title to your 
form, you are ready to create your form's layout.  

Insert a Layout Table 
When designing an InfoPath 2003 form, you can use a layout table to help you arrange 
controls and text in your form. 

• Move your insertion point underneath the table containing the form title by clicking 
the line below the Click to add form content section. 

• Press ENTER.  

• On the Standard toolbar, click Insert Layout Table.  

• Use the expanded menu to choose a 2 rows x 3 columns Table as shown in 
Figure 4. 
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Figure 4. Use the toolbar button to create a 2 x 3 table. 

 

• At this point, your form should look like Figure 5. 

 
Figure 5. Table with layout. 

Add Labels for Controls 
When filling out forms, users enter information by typing in text boxes, clicking items in 
lists, selecting check boxes, and performing other actions. The objects that users interact 
with are called controls. 

• Place your insertion point in the first cell at the top of the table. 

• Type “Sales Representative:”. 

• Press ENTER.  

• Type additional labels and adjust column widths in the layout table so that your form 
looks like Figure 6.  

 
Figure 6. Table with labels added. 

Insert Controls 
Now that you have added labels, you are ready to insert controls in the form.  

• At the top of the Layout task pane, click Controls.  

Notes 
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• From the Insert controls list in the Controls task pane, drag a Text Box control 
onto the form under the Sales Representative label.  

• From the Insert controls list, drag the Drop-Down List Box control onto the form 
under the Period label.  

• In the form, double-click the drop-down list box you just inserted.  

• Under List box entries in the Drop-Down List Box Properties dialog box, click 
Add.  

• In the Value box in the Add Choice dialog box, type “January 2004”. 

• Click OK.  

• Click Add. 

• In the Value box, type “February 2004”. 

• Click OK.  

• Click Add. 

• In the Value box, type “March 2004”. 

• Click OK. The List Box Properties dialog box looks like Figure 7. 
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Figure 7. List Box Properties dialog box  

• Click OK. 

• From the Insert controls list in the Controls dialog box, drag the Text Box control 
onto the form under the E-mail Address label.  

• From the Insert controls list, drag the Drop-Down List Box control onto the form 
under the Department label.  

Note   For this exercise, we leave the Department drop-down list box empty. 

Your form should now look like Figure 8. 

 
Figure 8. Form with controls. 

Notes 
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Insert a Repeating Section 
FabriKam sales representatives typically visit many customers in a given month. In this 
step, you add a repeating "customer name" section to the form to collect customer data. 
Sales representatives can insert as many of these sections as they need into their sales 
report forms. 

• Drag a Repeating Section control from the Controls task pane onto the form, just 
under the second layout table.  

• Click inside the repeating section. 

• Type “Customer Name:”.  

• From the Insert controls list in the Controls task pane, drag the Text Box control 
onto the form next to the Customer Name label.  

• You can change the width of the text box using the Text Box Properties dialog 
box. Double-click the text box to open the Text Box Properties dialog box. 

• In the Text Box Properties dialog box, click the Size tab.  

• Under Size, in the Width box, type 300. Leave px as the unit of measurement.  

• Click OK. 

Insert a Repeating Table 
Customers often purchase multiple products from FabriKam sales representatives. If you 
include a repeating table inside the repeating section, sales representatives can record the 
details about each product they've sold to a customer.  

• From the Insert controls list in the Controls dialog box, drag a Repeating Table 
control onto the form under the Customer Name box (but still within the repeating 
section).  

• In the Number of columns box in the Insert Repeating Table dialog box, type “4”. 

• Click OK.  

• Click above the first cell in the new table. 

• Type “Name”. 

• Press TAB. 

• Type “Price”. 

• Press TAB. 

• Type “Units Sold”. 

• Press TAB. 

• Type “Total”. Your form should now look like Figure 9. 
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Figure 9. Form with repeating table. 

Insert an Optional Section 
Customers occasionally ask FabriKam sales representatives to handle their order in a 
customized fashion. To record these special requests, or to record other supplementary 
notes about the customer, you can create an optional "Notes" section in the sales report 
form. This section won't appear unless the person filling out the form chooses to add it.  

• Select Insert | More Controls.  

• From the Insert controls list in the Controls task pane, drag the Optional Section 
control onto the form under the repeating table but inside the repeating section.  

• Click inside the optional section. 

• Type “Notes:”.  

• From the Insert controls list in the Controls task pane, drag the Rich Text Box 
control onto the form under the Notes: label. You use this rich text box to store 
notes about each customer.  

Your form should now look like Figure 10. 

Notes 
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Figure 10. Form with optional section. 

Apply a Color Scheme 
The form that you have created looks pretty plain. You can apply a color scheme to the 
form to make it look more interesting. 

• Select Format | Color Schemes.  

• In the Apply a color scheme list in the Color Schemes task pane, click 
Burgundy. Your form should now look like Figure 11. 

 

 

Notes 
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Figure 11. Form with color scheme. 

Insert a Footer 
FabriKam sales representatives often print copies of their form before submitting them to 
management. Therefore, you should consider how your form will look when it is printed. In 
the following steps, you add footers and page breaks to your form. 

• Select View | Header and Footer.  

• On the Print Settings tab in the View Properties dialog box, click Footer.  

• In the Print form with this footer text box in the Footer Format dialog box, type 
FabriKam Confidential. Page.  

• In the Insert Auto Text list, click Current Page.  

• The text in the Print form with this footer text box should look like Figure 12. 

 
Figure 12. The footer includes static text and the current page number. 

• Click OK. 

• Click OK to close the View Properties dialog box. 

Insert a Page Break 
If you want data about each customer to print on a separate page, you can add a page 
break after the repeating "customer name" section. 

• In the form, place your insertion point underneath the repeating section.  

• Select Insert | Page Break.  

In design mode, a page break appears as a dashed line in the form area. If you preview 
your form, you won't see this dashed line or any other indication of the page break. To see 
how the page break affects your form when it is printed, click Print Preview on the 
Standard toolbar.  

Preview the Form 
• On the Standard toolbar, click Preview Form. The form opens in a new window.  

Notes 
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• Add a row to the repeating table by placing your cursor inside the table and 
pressing CTRL+ENTER.  

• Insert a new "customer name" section by clicking Insert item at the bottom of the 
form.  

• Insert the optional "Notes" section by clicking Click here to insert.  

Close and Save the Form Template 
• To close the preview window, select File | Close Preview (or select the Close 

Preview button on the Standard toolbar).  

• Select File | Save As. 

• Click Save. 

• Browse to C:\Microsoft Hands-On-Lab\HOL-BRP21\Source\Exercises\LabWork. 

• In the File name text box, type “MyTemplate”. 

• Click Save. 



HOL: Building Solutions using Microsoft Office InfoPath 2003 
 

Notes 

 

 

 

 

 Page 19 

Exercise 4: Deploy a Form from InfoPath 2003 
The sales report form you created in the previous exercise is ready to be shared with sales 
representatives at FabriKam.  

One way to share a form with others in your organization is to publish it to a SharePoint 
form library. You can also deploy the form by e-mailing it to the potential users of the form. 
In this exercise, you try out both techniques.  

Publish the Form to a Form Library 
• The form you created in the last exercise should still be open in Design mode. If it 

isn’t, click Design a Form in the Fill Out a Form dialog box and choose 
MyTemplate.xsn.  

As part of the publishing process, specify form library columns. 

• On the File menu, click Publish.  

• On the first page of the Publishing Wizard, click Next.  

• On the second page of the wizard, select To a SharePoint form library. 

• Click Next.  

• On the next page of the wizard, select Create a new form library 
(recommended). 

• Click Next.  

• In the Enter the location of your SharePoint site list, select http://fabrikam1. 

• Click Next.  

• In the Name box, type “FabriKam Sales Reports”. 

• Click Next.  

• On the next page of the wizard, click Add.  

• In the Select a Field or Group dialog box, select field1.  

• In the Column name box, replace field1 with Sales Representative. This text is 
what appears at the top of the column in the form library. 

• Click OK.  

• To complete the wizard, click Finish.  

• A page appears indicating that the form was successfully published. This page 
contains the URL for the form library.  

• Select the Open this form from its published location check box. 

• Click Close. The form library opens in Microsoft Internet Explorer. 
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• After looking over the result, select File | Close to return to InfoPath 2003. 

Promote Additional Form Data to a Form Library 
After you have finished publishing your form to the form library, you can choose to promote 
additional form data to columns in the form library. 

• In design mode, select Tools | Form Options. 

• Click the Form Library Columns tab.  

• Click Add. 

• In the Select a Field or Group dialog box, click field4.  

• In the Column name box, replace field4 with Dept.  

• Click OK. 

• Click OK to close the Form Options dialog box. 

• Select File | Save. 

Verify that the New Column was Added 
• Navigate to Start | Internet. 

• In Internet Explorer, type “http://fabrikam1/fabrikam sales reports” in the Address 
text box.  

• Press ENTER. You see the Web page shown in Figure 13. 

 
Figure 13. The Sales Reports list includes Sales Representative and Department 
columns. 

• Select File | Close. 

Notes 
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Send the Form as an E-mail Message Attachment 
In addition to publishing the form on form library, you may also want to deploy it using e-
mail. 

• Select File | Send Form as Attachment. An e-mail message opens in Outlook 
2003 with the InfoPath 2003 form attached to it.  

• In the To box, type “LuisB@fabrikam.com”.  

• Click Send.  

Open the Form and Fill It Out 
Now that you have sent the form as an attachment in an e-mail message, you need to 
confirm that it was deployed correctly. In this procedure, you are acting as the sales 
representative who has received the sales report form.  

• Navigate to Start | E-mail. 

• In Outlook 2003, click Send/Receive. You receive the FabriKam Sales Reports 
email sent in the previous step. 

• Double-click the MyTemplate.xsn attachment. You receive a security warning.  

• Click Open. The FabriKam sales report form opens in InfoPath 2003.  

• Fill out the form. 

• Select File | Save As.  

• In the Save As dialog box, in the File name box, type “http://fabrikam1/fabrikam 
sales reports”.  

• Click Save.  

• Navigate to Start | Internet. 

• In Internet Explorer, type “http://fabrikam1/fabrikam sales reports” in the Address 
text box.  

• Press ENTER. You see the SharePoint list, including the form you added. 

Disable Design Mode 
When deploying a form to a group of users, by default they can open the form in design 
mode and make changes to the structure and layout of the form. In this exercise, you learn 
how to disable this functionality and prevent users from modifying the design of your form. 

• Return to InfoPath 2003.  

• Select File | Design a Form. 
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• In the Design a Form task pane, under Open a form in design mode, click the 
MyTemplate form.  

• Select Tools | Form Options.  

• On the General tab in the Form Options dialog box, select the Enable protection 
check box. 

• Click OK.  

• Select File | Save. 

• Select File | Fill Out a Form. 

• Click Open. 

• Browse to C:\Microsoft Hands-On-Lab\HOL-BPR21\Source\Exercises\LabWork. 

• Select MyTemplate.xsn. 

• Click Open. Note that the Design this Form button in the Standard toolbar is 
disabled. 

• Select File | Exit.  
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Exercise 5: Work with Advanced Controls in InfoPath 2003 
Employees in the sales department at FabriKam have requested that the IT department 
add several new features to their existing sales report form. In particular, they want to:  

• Attach documents, worksheets, and other files to their forms.  
• Efficiently manage large amounts of data in the form.  
• Have the option to include either a customer name or a customer ID section.  
• Filter customers based on location.  
The IT department plans to update the existing form by adding several new controls. These 
controls allow sales representatives to work more efficiently. 

In this exercise, you learn how to create a file attachment control that allows users to attach 
documents to their forms and how to customize controls by changing their property 
settings. In addition, you use advanced InfoPath 2003 controls, including the master/detail 
control and the choice control, to manage the way data is displayed in a form. Finally, you 
learn how to design filters so that users can filter data in a form. 

Add a File Attachment Control to the Form 
When filling out sales report forms sales representatives often want to attach 
supplementary files, such as Microsoft Office Word 2003 documents, to their forms. As a 
form designer, you can add a special type of control to your form, called a file attachment 
control, which allows users to attach files to their form. In this exercise, you learn how to 
add this control to your form and specify the type of file that you want users to attach 

• Start InfoPath 2003 by navigating to Start | All Programs | Microsoft Office | 
Microsoft Office InfoPath 2003.  

• In the Fill Out a Form dialog box, click Design a Form.  

• In the Design a Form task pane, click On My Computer.  

• In the Open in Design Mode dialog box, browse to C:\Microsoft Hands-On-
Lab\HOL-BRP21\Source\Exercises.  

• Select Lab BPR21-02-Attach.xsn. 

• Click Open. The FabriKam Sales Report form opens in design mode.  

• In the Design Tasks task pane, click Controls.  

• Place your cursor below the repeating section at the bottom of the form.  

• Under Insert controls, click File Attachment.  

Limit the Type of File Attachments  
Now that you have added the file attachment control to your form, you can specify the type 
of file you want to allow users to attach.  
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• In the form, double-click the file attachment control.  

• In the File Attachment Properties dialog box, on the Data tab, select the Allow 
the user to attach only the following file types check box.  

• In the box underneath the check box, type “doc”. This choice limits the types of files 
that users can attach to Word (.doc) files. 

• Click OK.  

• Click Preview Form on the Standard toolbar. 

• Click the Click here to attach a file link. You see the Attach File dialog box shown 
in Figure 14. 

 
Figure 14. In this instance, you can only attach files with a doc extension. 

• Click Cancel. 

• To close the preview window and return to design mode, click Close Preview on 
the Standard toolbar.  

Customize a Control's Properties 
If you want to customize the behavior and appearance of a particular control, you can 
change its property settings. For example, you can specify a character limit for a text box 
by changing the properties for that text box. You can also use properties to change the size 
for several controls at once and customize menu commands associated with a repeating 
table control. 

Limit the Number of Characters in a Text Box 
• With the form still open, double-click the Units Sold text box in the repeating table.  

• In the Text Box Properties dialog box, click the Display tab.  

Notes 
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• Under Options, select the Limit text box to check box. 

• In the characters box, type “4”. 

• Click OK.  

• On the Standard toolbar, click Preview Form. The form opens in a new window.  

• To test your changes, in the Units Sold box, type “12345”. The text box accepts 
only 4 characters.  

• To return to design mode, click Close Preview on the Standard toolbar.  

Change Properties for Multiple Controls at Once 
While you can set the properties for a single control, you can also specify certain 
properties, including size, padding, margins, and alignment settings, for several controls at 
once.  

• In the repeating table, click the Name text box control, and then hold down CTRL 
and click each remaining control in the table.  

• Select Format | Properties.  

• In the Properties (Multiple Selection) dialog box, type “1” in the Width box. 

• Change the unit of measure from % to in. 

• Click OK. Each control in the repeating table is now 1 inch wide.  

Customize Menu and Toolbar Commands for a Repeating Table 
You can customize the menu commands that sales representatives use to add or remove 
rows in the repeating table. By default, users interact with these menu commands by 
clicking a shortcut menu button in the upper-left corner of the table. However, by adding an 
additional access point for these commands, you can make your form more flexible. In the 
next example, you add a custom button, called Insert New Item, to the Form toolbar. 

• Double-click the Repeating Table label below the table on the form.  

• In the Repeating Table Properties dialog box, on the Data tab, click Customize 
Commands. The Table Commands dialog box appears with Insert selected in the 
Action list.  

• In the Location for the command list, select the Form toolbar check box.  

• In the Command name box, change the default text to “Insert New Item”. 

• Click OK. 

• Click OK.  

• On the Standard toolbar, click Preview Form.  
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• To test your changes, place your cursor in the Name box in the repeating table.  

• To insert a new row in the table, on the Form toolbar, click Insert New Item.  

• To return to design mode, on the Standard toolbar, click Close Preview.  

• Select File | Close. When prompted to save changes, choose No. 

Add a Master/Detail Control to the Form 
FabriKam wants its sales representatives to specify not only which products they sold, but 
also the parts that belong to each of those products. In the next exercise, you establish a 
master/detail relationship between two repeating tables. By setting up this type of 
relationship, you ensure that related detail information appears in a detail control whenever 
a sales representative selects an item in the master control.  

Open a Template 
• Select File | Design a Form.  

• In the Design a Form task pane, click On My Computer.  

• In the Open in Design Mode dialog box, browse to C:\Microsoft Hands-On-
Lab\HOL-BRP21\Source\Exercises.  

• Select Lab BPR21-05-MD.xsn. 

• Click Open. The FabriKam Sales Report form opens in design mode.  

Create the Master Control  
• Double-click the Repeating Table label below the Units Sold table on the form.  

• In the Repeating Table Properties dialog box, click the Master/Detail tab.  

• Under Master/detail settings, select Set as master.  

• In the Master ID box, type “master1”.  

• Click OK. 

You now have a master control.  

Create the Detail Control  
In this step, you designate a detail control. This control displays the parts associated with 
selected items in the master control. 

• Double-click the Repeating Table label below the Parts belonging to the unit 
table.  

• In the Repeating Table Properties dialog box, click the Master/Detail tab.  
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• Under Master/detail settings, select Set as detail.  

• In the Link to master ID list, select master1.  

• Under Master/detail relationship, select By key field.  

• Click Select XPath next to the Key field (master) box.  

• In the Select a Field or Group dialog box, select the unitName field in the item 
group. 

• Click OK.  

• Click Select XPath next to the Key field (detail) box.  

• In the Select a Field or Group dialog box, select the unitNameReference field in 
the Part group. 

• Click OK.  

• Click OK. 

• On the Standard toolbar, click Preview Form.  

• To test the master/detail relationship, click on different rows in the Units Sold table. 
Notice how the information in the Parts belonging to the unit table changes based 
on your selection in the Units Sold table.  

• To return to design mode, click Close Preview on the Standard toolbar.  

Add a Choice Control to the Form 
Choice controls allow users to replace one section with another in a form. For example, in 
the sales report form, you can let sales representatives choose to designate customers 
either by name or by numeric ID. In the following exercise, you learn how to create this 
type of control. 

Create a Choice Control 
• With the form still open, delete the Customer Name label and text box.  

• If it is not already there, place your cursor above the Units Sold repeating table.  

• Select Insert | More Controls.  

• In the Controls task pane, click Choice Group.  

• In the control labeled Choice Section (default), type “Customer Name:”. 

• In the Controls task pane, click Text Box.  

• In the control labeled Choice Section, type “Customer ID:”. 

• In the Controls task pane, click Text Box.  
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• Double-click the Choice Section (default) label.  

• In the Field or group name box in the Choice Section Properties dialog box, 
replace the default text with “CustomerName”. 

• Click OK.  

• Double-click the Choice Section label.  

• In the Field or group name box in the Choice Section Properties dialog box, 
replace the default text with “CustomerID”. 

• Click OK.  

• On the Standard toolbar, click Preview Form.  

• To test the choice control, move your pointer over the Customer Name text box.  

• When a shortcut menu button appears, click it, and then on the shortcut menu, click 
Replace with CustomerID. The default section, Customer Name, is replaced with 
an alternative section, Customer ID.  

• Click Close Preview. 

• Select File | Close. When prompted to save, click No. 

Add a Filter to the Form 
In the next step, you set up your form so that sales representatives can filter customers by 
location. 

• Select File | Design a Form.  

• In the Design a Form task pane, click On My Computer.  

• In the Open in Design Mode dialog box, browse to C:\Microsoft Hands-On-
Lab\HOL-BRP21\Source\Exercises.  

• Select Lab BPR21-05-Filter.xsn, and then click Open. The FabriKam Regional 
Sales Report form opens in design mode.  

• Double-click the Repeating Table label below the repeating table in the form.  

• In the Repeating Table Properties dialog box, click the Display tab.  

• Under Filter, click Filter Data.  

• In the Filter Data dialog box, click Add.  

• Under Display data that meets the following conditions in the Specify Filter 
Conditions dialog box, in the third box, click Select a field or group.  

• In the Select a Field or Group dialog box, double-click regionFilter. This field 
corresponds to the list control in the form.  
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• To add an additional filter condition, click And. You now have a second filter 
condition.  

• In the box in the first condition that is furthest to the right, change and to or.  

• In the second row, click on first box, and then click Select a field or group.  

• In the Select a Field or Group dialog box, double-click regionFilter. Again, this 
field corresponds to the list control in the form.  

• Click on the third box, and then select Type Text.  

• Type Show All. The Specify Filter Conditions dialog box looks like Figure 15. 

 
Figure 15. The filter includes an Or condition. 

 
• Click OK three times to close all open dialog boxes.  

• On the Standard toolbar, click Preview Form.  

• To test the filter, try out different values in the drop-down list and observe the data 
in the repeating table.  

• Click Close Preview. 

• Select File | Exit. When prompted to save changes, click No. 

If you are continuing on to another module in this series after you complete this module, 
you do not need to shut down and restart the Virtual PC image. 

 
END OF MODULE 

 
(Additional reference material is at the end of this document.) 

 
If you are leaving the lab at this time, please press the RIGHT ALT and ENTER keys 

together to return the window to a restored state.  

Notes 
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Module 2: Customizing InfoPath Solutions with Business Logic 
and User Roles 
You’ve created simple InfoPath 2003 forms and are now looking to customize samples or 
create your own solutions. In this module you’ll be introduced to implementing simple 
business logic in InfoPath forms. You’ll learn how you can use the new InfoPath SP1 
features to embed user roles in your forms.  

Estimated time to complete this module: 30 minutes 

Objectives 
After completing this module, you will be able to: 

• Specify that a text box cannot be blank.  
• Create a data entry pattern for a text box.  
• Create a formula to automatically calculate totals.  
• Create a rule to automatically fill in an e-mail address based on values in another field.  
• Add script-based validation to a form.  
• Add an additional view to a form. 
• Create roles for a form. 
• Use rules to display different views based on the user's current role. 

Exercises 
 
• Change Control Properties to Prevent Data Entry Errors 

• Add Data Entry Features to the Form 

• Add Script-Based Validation 

• Change Views Based on User Roles 

 
The sample files for this module may be found in the C:\Microsoft Hands-On-Lab\HOL-
BPR22\Source\Exercises folder.   
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Exercise 1: Change Control Properties to Prevent Data Entry 
Errors 
Like any organization, FabriKam aims to reduce costs and increase efficiency whenever 
possible. The finance department has noticed that sales are often delayed because sales 
representatives enter the wrong information in forms or forget to fill out certain fields.  

In this exercise, you learn techniques to help prevent these kinds of data entry mistakes 
and omissions. Specifically, you make changes to a form to require the user to enter a 
sales representative name and a correct corporate e-mail address. 

Make the Sales Representative Text Box Required  
• Navigate to Start | All Programs | Microsoft Office | Microsoft Office InfoPath 

2003.  

• In the Fill Out a Form dialog box, click Design a Form.  

• In the Design a Form task pane, click On My Computer.  

• In the Open in Design Mode dialog box, browse to C:\Microsoft Hands-On-
Lab\HOL-BPR22\Source\Exercises.  

• Select LabBPR22-01.xsn. 

• Click Open. The FabriKam sales report form opens in design mode.  

• Double-click the Sales Representative text box.  

• On the Data tab in the Text Box Properties dialog box, select the Cannot be 
blank check box. 

• Click OK.  

Test the Change 
• To test your changes, click Preview Form on the Standard toolbar. Notice that the 

Sales Representative text box includes a red asterisk, as shown in Figure 1. 

 
Figure 16. Sales Representative text box with asterisk 

• Hover the mouse cursor over the Sales Representative text box. You see a 
screentip with the text Cannot be blank. 

• Type your name in the Sales Representative text box. 

• Press TAB to move out of the text box. Notice that the red asterisk has 
disappeared. The field is now valid. 

• Click the Close Preview toolbar button to return to Design mode. 

Notes 
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Assign a Data Entry Pattern to the E-mail Address Text Box 
You can create data entry patterns to do the same sort of data validation in a more precise 
way. In this step, you make an error alert appear if a user inadvertently enters a personal 
e-mail address instead of a work e-mail address.  

• Double-click the E-mail Address text box.  

• In the Text Box Properties dialog box, on the Data tab, click Data Validation.  

• In the Data Validation dialog box, click Add.  

• Make sure that the first box under If this condition is true contains the control's 
field ("email"), and then in the second box, click does not match pattern.  

• In the third box, click Select a pattern.  

• In the Data Entry Pattern dialog box, in the Standard patterns list, select Custom 
pattern to clear the existing text in the Custom pattern box. Patterns use the 
syntax defined by the W3C XML Schema pattern restrictions.  

• In the Insert special character list, select Any letter.  

• In the Insert special character list, select One or more.  

• In the Custom pattern box, type “@FabriKam” after the existing characters.  

• In the Insert special character list, select Period.  

• In the Custom pattern box, type com after the existing characters. The Data Entry 
Pattern dialog box looks like Figure 2. 

 
Figure 17. The custom pattern defines an e-mail address. 

• Click OK to exit the Data Entry Pattern dialog box.  

• In the ScreenTip box in the Data Validation dialog box, type “Please use your 
FabriKam e-mail address”. This text appears when a user points to or right-clicks 
the control.  

Notes 
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• Close all open dialog boxes.  

Test the E-mail Data Validation 
• Click Preview Form on the Standard toolbar.  

• Type “name@example.com” in the E-mail Address text box.  

• Press TAB. A dashed red line appears around the text box (Figure 3), which 
indicates that there's a problem with the data you entered.  

 
Figure 18. The red dashed line indicates a data validity problem. 

• Move your mouse pointer over the text box. You see the ScreenTip you specified.  

• Click the Close Preview button on the Standard toolbar. 

Notes 
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Exercise 2: Add Data Entry Features to the Form  
The sales report form contains a table that contains four columns named item name, item 
price, units sold, and total sales. The process of filling out this table can be time-consuming 
and prone to error. In this exercise, you learn how to make it easier for users to avoid 
simple mistakes and improve their overall experience of filling out a form.  

First, you can make the form calculate totals automatically. 

Calculate Total Sales Automatically 
• With the form still open in design mode, double-click the text box inside the Total 

column in the repeating table.  

• In the Text Box Properties dialog box, on the Data tab, select Decimal (double) 
from the Data type list.  

• Click Format.  

• Under Format in the Decimal Format dialog box, click Currency.  

• In the Decimal Places list, select 2. 

• Click OK.  

• In the Text Box Properties dialog box, click Apply.  

• Under Default Value, click the fx button.  

• In the Insert Formula dialog box, click Insert Field or Group.  

• In the Select a Field or Group dialog box, click itemPrice. 

• Click OK. The field name itemPrice appears in the Formula box. This is the first 
part of the expression.  

• To continue building the formula, type the multiplication symbol (“*”) after 
itemPrice.  

• Click Insert Field or Group again.  

• In the Select a Field or Group dialog box, click unitsSold.  

• Click OK. The finished expression, itemPrice * unitsSold, appears in the Formula 
box.  

• To close the Insert Formula dialog box, click OK.  

• In the Text Box Properties dialog box, click the Display tab. 

• Select the Read-only check box. 

• Click OK.  
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Test the Change 
• Click Preview Form on the Standard toolbar.  

• In the Price and Units Sold fields, type numbers. Note that the Total field 
automatically shows the results of multiplying unit price by number sold.  

• Click Close Preview on the Standard toolbar. 

Draw Attention to Quantities Over 100 
In addition to calculating totals automatically, you can use conditional formatting in 
conjunction with rules to congratulate sales representatives when they sell more than 100 
units of a particular product. 

• With the form still open in design mode, double-click the text box inside the Units 
Sold column.  

• In the Text Box Properties dialog box, on the Data tab, click Rules.  

• In the Rules dialog box, click Add.  

• In the Name box, type “Congratulate”. 

• Click Set Condition.  

• In the Condition dialog box, make sure that the first box under If this condition is 
true contains the control's field ("unitsSold").  

• In the second box, select is greater than.  

• In the third box, select Type a number. 

• Type “100”. 

• Click OK.  

• In the Rule dialog box, click Add Action.  

• Type “Well done!” in the Message box. 

• Click OK.  

• Click OK.  

• Click OK. (You should now be in the Text Box Properties dialog box.) 

• In the Text Box Properties dialog box, click the Display tab. 

• Click Conditional Formatting.  

• In the Conditional Formatting dialog box, click Add.  

• In the Conditional Format dialog box, make sure that the first box under If this 
condition is true contains the control's field ("unitsSold").  

• In the second box, select is greater than.  
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• In the third box, select Type a number. 

• Type “100”.  

• Under Then apply this formatting, select the Bold check box.  

• In the Font Color list, select a shade of green. 

• Close all open dialog boxes.  

Test the Changes 
• On the Standard toolbar, click Preview Form.  

• In the Units Sold field, type “101”. 

• Press TAB to move out of the field. You see a message box with the text you 
specified, as shown in Figure 4. 

 
Figure 19. The message box displays the text you specified. 

• Click OK. The number in the Units Sold text box is now shown in a bold green font. 

• Click Close Preview on the Standard toolbar. 

Fill in E-mail Addresses Automatically  
FabriKam e-mail addresses use a standardized form: the employee's last name followed by 
@FabriKam. You can use rules in conjunction with formulas to automatically fill in the e-
mail address field so that users don't have to. 

• With the form still open in design mode, double-click the Sales Representative text 
box.  

• On the Data tab in the Text Box Properties dialog box, click Rules.  

• In the Rules dialog box, click Add.  

• In the Name box, type “Set e-mail”. 

• Click Set Condition.  

• In the Condition dialog box, make sure that the first box under If this condition is 
true contains the control's field ("salesRepresentative").  

• In the second box, select is not blank. 

• Click OK.  

Notes 
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• In the Rule dialog box, click Add Action.  

• In the Action list in the Action dialog box, select Set a field's value.  

• Next to the Field box, click the Data Source button.  

• In the Select a Field or Group dialog box, select email. 

• Click OK.  

• Next to the Value box, click the Insert Formula button.  

• In the Insert Formula dialog box, click Insert Function.  

• In the Insert Function dialog box, in the Categories list, click Text.  

• In the Functions list, click concat. 

• Click OK. The formula should look like Figure 5. 

 
Figure 20. Insert Formula dialog box. 

• In the Formula box, click the first occurrence of double click to insert field. 

• Click Insert Function.  

• In the Insert Function dialog box, in the Categories list, click Text.  

• In the Functions list, click substring-after. 

• Click OK. The formula should look like Figure 6. 

 

Notes 
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Figure 21. Insert Formula dialog box.  

• Replace the first occurrence of double click to insert field with: ., " " (meaning to 
substring the current field, which in this case is salesRepresentative, after the first 
space). The formula should look Figure 7. 

 
Figure 22. Insert Formula dialog box. 

• Replace the next occurrence of double click to insert field with  
"@FabriKam.com"  

  Include the quotes. The formula should look like Figure 8. 

 
Figure 23. Insert Formula dialog box.  

• Delete the second comma and last occurrence of double click to insert field. The 
formula should look like Figure 9.  

Notes 
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Figure 24. Insert Formula dialog box.  

• Close all open dialog boxes.  

Test the Changes 
• Click Preview Form on the Standard toolbar.  

• In the Representative field, type "FirstName LastName". 

• Press TAB to leave the field. The E-mail Address text box is filled in as shown in 
Figure 10. 

 
Figure 25. The e-mail address was created based on what you entered in the Sales 
Representative field. 

• On the Standard toolbar, click Close Preview. 

Notes 
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Exercise 3: Add Script-Based Validation 
When built-in data validation features are not sufficient, you can create an event handler to 
respond to a data validation event. In this exercise, you learn how to validate the price of 
an item by adding an OnValidate event handler to your form. 

Add an OnValidate Event Handler 
• In the repeating table, double-click the text box inside the Price column.  

• In the Text Box Properties dialog box, under Validation and Rules, click Data 
Validation.  

• In the Data Validation dialog box on the Events list, select OnValidate. 

• Click Edit. The Microsoft Script Editor (MSE) program starts. 

• In MSE, locate the following comment in the code:  
function msoxd_my_itemPrice::OnValidate(eventObj)  

{      

 // Write your code here  

}  

• Replace the above code with the code you want to run when the event occurs:  
function msoxd_my_itemPrice::OnValidate(eventObj)  

{     

  // Get the value of the itemPrice field.      

 var price = Number(eventObj.Site.text);      

 if (isNaN(price))      

 {          

  // If the price is not a number, report an error.          

  eventObj.ReportError(              

   eventObj.Site,      // Node with the error              

  "Price must be a number.",  // Message for the error              

  false);         // Site dependent error      

 }      

 else if (price < 0)      

 {          

  // If the price is less than zero, report an error.          

  eventObj.ReportError( 

           eventObj.Site,         // Node with the error  

             "Price must be greater than zero.", // Message for the error 

           false);          // Site dependent error      

 }  
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}  

 

NOTE: If you would rather not type the code, open Notepad and find the file 
BPR22CodeSnippets.txt in C:\Microsoft Hands-On-Lab\HOL-BPR22\Source\Exercises. You can 
copy and paste the code from Notepad to the Microsoft Script Editor. 

• Save the script, and then close MSE.  

• Click OK to close the Data Validation dialog box. 

• Click OK to close the Text Box Properties dialog box. 

Test the Code 
Now that you have added an OnValidate event handler to your form, you need to preview 
your form in order to test that the script-based validation works as expected. 

• In design mode, click Preview Form on the Standard toolbar.  

• In the Price field, type “abc”. 

• Press TAB. Notice that a red-dashed border appears around the text box, indicating 
that an error is associated with this field.  

• Move the pointer over the field to display a hint for fixing the error, as shown in 
Figure 11. 

 
Figure 26. Price field with red-dashed border  

• In the Price field, type “-10”. 

• Press TAB. When you move the pointer over the field to display a hint for fixing the 
error, you see the message shown in Figure 12. 

 
Figure 27. Price field with greater than zero message. 

• Click Close Preview on the Standard toolbar. 

• Close the form without saving changes. 

Notes 
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Exercise 4: Change Views Based on User Roles 
The management team at FabriKam reviews each of the InfoPath 2003 forms that sales 
representatives fill out. Because the management team is interested only in sales deals 
that exceed a certain amount of money, your department is asked to add an additional view 
to the sales form that shows only those deals.  

The FabriKam sales report form has a default view, called "View 1 (default)," which sales 
representatives see when they open and fill out a form. In this exercise, you rename the 
default view and add a blank view to the form.  

Open the Form in Design Mode 
• Select File | Design a Form.  

• In the Design a Form task pane, click On My Computer.  

• In the Open in Design Mode dialog box, browse to C:\Microsoft Hands-On-
Lab\HOL-BPR22\Source\Exercises.  

• Select LabBPR22-02.xsn, and then click Open. The FabriKam sales report form 
opens in design mode.  

Rename the Default View 
The only existing (and therefore default) view for the form is named View 1. Before adding 
a view to the form, it is a good idea to give the default view a more descriptive name.  

• In the Design Tasks task pane, click Views.  

• In the Select a view list in the Views task pane, click View 1 (default), and then 
click View Properties.  

• On the General tab of the View Properties dialog box, in the View name box, type 
“Employee View”.  

• Click OK. Note that in the Views task pane, the view name has been changed to 
Employee View (default).  

Create a New View 
• In the Views task pane, under Actions, click Add a New View.  

• In the Add View dialog box, type Manager View.  

• Click OK. At this point, you have added an empty view to the form. 

Add Content to the View 
The management team wants the Manager view to look the same as the default view of the 
sales report, but with a few customizations. The easiest way for you to create this view is to 
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copy the contents from the original view into the new view, and then make the requested 
modifications. 

• With the form still open, in the Views task pane, click Manager View 2 in the 
Select a view list.  

• Click the arrow at the right side of the selected row. 

• From the drop-down menu, select Delete. 

• Click Yes. 

• Click View 2, and then click View Properties.  

• On the General tab of the View Properties dialog box, in the View name box, type 
“Manager View”.  

NOTE: If the paste action doesn’t seem to work, you may be encountering a conflict between 
InfoPath 2003 and Microsoft Virtual PC. To work around the problem, follow these steps after 
copying the contents of the view to the clipboard: 

1. Open Microsoft Office Word. 

2. Select Edit | Paste to paste the view into the default Word document. 

3. After the view has been pasted, close Word without saving changes. 

4. Back in InfoPath, select Edit | Paste to paste the contents of the Employee View into the 
Manager View.  

Apply a Color Scheme 
The two views should now look identical. To avoid confusion between the two views, you 
can apply a different color scheme to the Manager view. 

• Select Format | Color Schemes.  

• In the Color Schemes task pane, click Blue.  

Rename the Total Field 
Now that the two views look different, you can start making modifications to the new view. 
The management team is only interested in the total sales that exceed $1,000. That means 
that you need to filter out any unwanted information. Before you create a filter, change the 
field name that is associated with the Total text box. This makes it easier to identify and 
work with the field in the data source. 

• In the form, under Total in the repeating table, double-click the text box.  

• In the Text Box Properties dialog box, on the Data tab, type “total” in the Field 
name box.  
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• Click OK. You see a notification dialog box warning of possible problems if you 
change the name of the field.  

• Click Yes to confirm that you want to make the change. 

Apply a Filter 
Now that you have renamed the field, you're ready to apply a filter to the form. This filter 
allows managers to filter for total sales that exceed $1,000. 

• In the form, below the repeating table, double-click the Repeating Table label.  

• In the Repeating Table Properties dialog box, click the Display tab, and then click 
Filter Data.  

• In the Filter Data dialog box, click Add.  

• In the Specify Filter Conditions dialog box, click total in the first box under 
Display data that meets the following conditions.  

• In the second box, select is greater than.  

• In the third box, select Type a number. 

• Type “1000” in the box.  

• Close all open dialog boxes.  

Create User Roles 
The sales form now has two views, one for sales representatives and another for the 
management team. To associate the correct view with its intended users, you must create 
user roles for the form.  

Note   Two groups have already been created in Microsoft Active Directory® services: 
FABRIKAM\employees and FABRIKAM\managers. 

• With the form still open, on the Tools menu, click User Roles.  

• In the Manage User Roles dialog box, click Add.  

• In the Role name box in the Add User Role dialog box, type “Employee”.  

• Select the Group name check box. 

• Type “FABRIKAM\employees” in the Group names box.  

• Select the Set as initiator check box. 

• Click OK.  

• In the Manage User Roles dialog box, click Add.  

• In the Role name box in the Add User Role dialog box, type “Manager”.  
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• Select the Group name check box. 

• Type “FABRIKAM\managers” in the Group names box.  

• Click OK. The Manage User Roles dialog box should look like Figure 13 after you 
add user roles to the form. 

 
Figure 28. Manage User Roles dialog box. 

• Click OK to close the dialog box. 

Switch Views Based on User Role 
Now that you have created two user roles for the form, you can use rules to specify which 
view of the form is displayed, based on the user's role when they open the form.  

• With the form still open, select Tools | Form Options.  

• In the Form Options dialog box, click the Open and Save tab. 

• Click Rules.  

• In the Rules for Opening Forms dialog box, click Add.  

• In the Rule dialog box, click Set Condition.  

• In the Condition dialog box, select User's current role in the first box under Apply 
the rule when this condition is true.  

• In the second box, select is equal to.  

• In the third box, select "Employee". 

• Click OK.  

• In the Rule dialog box, click Add Action.  

• In the Action list in the Action dialog box, select Switch views. 

• Click OK.  

• Click OK. 

Notes 

 

 

 

 

 Page 45 



HOL: Building Solutions using Microsoft Office InfoPath 2003 
 

Notes 

 

 

 

 

 Page 46 

• In the Rules for Opening Forms dialog box, click Add. 

• In the Rule dialog box, click Set Condition.  

• In the Condition dialog box, select User's current role in the first box under Apply 
the rule when this condition is true.  

• In the second box, select is equal to.  

• In the third box, select "Manager". 

• Click OK.  

• In the Rule dialog box, click Add Action.  

• In the Action list in the Action dialog box, click Switch views. 

• In the Views drop-down list, select Manager View. 

• Click OK.  

• Close all dialog boxes. 

Preview the Form Based on User Role 
Now that you created a second view of your form and added user roles and rules, you 
should preview the form to make sure it works correctly. InfoPath lets you preview a form 
with different roles applied. 

• Select File | Preview Form | With User Role.  

• In the Choose User Role to Preview dialog box, select Employee. The form 
opens in Preview mode with the Employee view. 

• Click Close Preview. 

• Select File | Preview Form | With User Role. 

• In the Choose User Role to Preview dialog box, select Manager. The form opens 
in Preview mode with the Manager view. 

• Click Close Preview. 

• Close the form without saving changes. 

• Select File | Exit to close InfoPath 2003. 

If you are continuing on to another module in this series after you complete this module, 
you do not need to shut down and restart the Virtual PC image. 

 
END OF MODULE 

 
(Additional reference material is at the end of this document.) 
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If you are leaving the lab at this time, please press the RIGHT ALT and ENTER keys 

together to return the window to a restored state. 
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Module 3: Working with XML Data and Custom Submit Processing 
In this module, you will learn how you can build more advanced InfoPath solutions. You’ll 
learn how to work with secondary data sources and how to program submit and receive 
buttons. You will also embed a custom control in your InfoPath 2003 solution. 

Estimated time to complete this module: 30 minutes 

Objectives 
After completing this module, you will be able to: 

• Retrieve data  
• Create data connections  
• Create secondary data sources  
• Retrieve data on demand  
• Create custom Submit commands  
• Enable offline support  

Exercises 
 
• Design a Form that Retrieves Data from a Web Service. 

• Populate a List Box with Values from an XML Document. 

• Submit a Form to a Web Service 

• Dynamically Update a Form with Data from a Web Service 

• Create Custom Submit Processes 

 
The sample files for this module may be found in the C:\Microsoft Hands-On-Lab\HOL-
BPR23\Source\Exercises folder.   
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Exercise 1: Design a Form that Retrieves Data from a Web Service 
FabriKam stores reports from its sales representatives in a back-end database exposed by 
using a Web service. The sales representatives can retrieve these reports in the form. This 
exercise shows you how to retrieve data from a Web service. We use the data source 
wizard to create a new form based on an existing Web service. 

Connect a Form to the Web Service 
• Open InfoPath 2003 by navigating to Start | All Programs | Microsoft Office | 

Microsoft Office InfoPath 2003. 

• In the Fill Out a Form dialog box, click Design a Form.  

• In the Design a Form task pane, click New from Data Connection.  

• In the Data Connection Wizard, click Web service. 

• Click Next.  

• On the next page of the wizard, click Receive data. 

• Click Next.  

• On the next page of the wizard, in the Enter the location of the Web service you 
want to use as your data connection box, type 
“http://fabrikam1:8080/FabrikamWS/bpr23ws.asmx”.  

• Click Next.  

• On the next page of the wizard, click RetrieveMySalesReports. 

• Click Next.  

• On the next page of the wizard, select s0:Period in the Parameters list. 

• Click Set Sample Value.  

Note   This Web service operation returns an XmlNode. In the WSDL this is defined as an 
xsd:any schema type. InfoPath 2003, therefore, does a sample query with the value you 
specified and tries to infer a schema from the sample instance. 

• In the Parameter Details dialog box, type “2004-01” in the Sample value box. 

• Click OK.  

• Click Next.  

• On the next page of the wizard, click Finish.  

Lay Out the Controls for Querying the Web Service 
Now that you created a form that is designed based on a Web service, you can add other 
data connections to the form, including secondary data sources that you can use to 
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populate controls dynamically on the form. 

• In the Data Source task pane, expand the queryFields group.  

• Continue expanding the groups until you see the period field.  

• Drag the period field to the table cell named Drag query fields here.  

• In the Data Source task pane, expand the dataFields group, and then expand all 
the child fields until you see the total field under the items group. The tree is shown 
in Figure 1. 

 
Figure 29. Navigate to the total field in the Data source tree. 

• Click ns1:salesReport in the Data source tree. Notice that salesReport and all its 
children are selected. 

• Drag the salesReport group to the table cell where it says Drag data fields here.  

• On the shortcut menu, click Section with Controls.  

Test the Form 
The form is now ready to test to make sure the connection and controls are working as 
expected. 

• On the toolbar, click Preview Form.  

• In the Period field, type “2004-01”.  

• Click Run Query. The form fills with information from the Web service. 

Notes 
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• In the Period field, type “2004-02”.  

• Click Run Query. InfoPath 2003 uses the Web service to fill the form with a 
different set of information. 

• Click Close Preview. 

• Close the form without saving changes. 
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Exercise 2: Populate a List Box with Values from an XML 
Document 
Now that you have created a form that is designed based on a Web service, you can add 
other data connections to the form, including secondary data sources that can be used to 
dynamically populate controls on the form.  

You can include data from several sources in to your form, including the following:  

• XML document  
• Database (Microsoft SQL Server or Microsoft Access only)  
• Web service  
• Document library or SharePoint list (Microsoft SharePoint® Products and Technologies)  
• Microsoft Windows SharePoint Services library or list  
In this exercise you set up a form to receive data from an XML file that is included in the 
form and use this data to populate a drop-down list. 

Add a Data Connection to an XML File 
In this step, you begin with a form similar to the form you created in the first exercise. 

• Select File | Design a form. 

• In the Design a Form task pane, click On My Computer. 

• Browse to C:\Microsoft Hands-On-Lab\HOL-BPR23\Source\Exercises. 

• Select LabBPR23-01.xsn. 

• Click Open.  

• Select Tools | Data Connections.  

• In the Data Connections dialog box, click Add.  

• In the Data Connection Wizard, click Receive data. 

• Click Next.  

• On the next page of the wizard, click XML document. 

• Click Next.  

• In the next page of the wizard, click Browse. 

• Browse to C:\Microsoft Hands-On-Lab\HOL-BPR23\Source\Exercises.   

• Select Periods.xml.  

• Click Open. 

• Click Next.  
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• Make sure the Automatically retrieve data when the form is opened check box 
is selected, and then click Finish. You see the notification dialog box shown in 
Figure 2. 

 
Figure 30. You can store the XML document as a part of the form. 

• Click Yes. This adds the XML document as a resource file in your form. That means 
the users always have access to the file, even when they are offline.  

• Click Close.  

Bind the Period Drop-Down to the Data Connection 
• In the form, double-click the Period list box (located to the left of Retrieve My 

Sales button).  

• On the Data tab of the List Box Properties dialog box, click Look up values in a 
data connection to a database, Web service, file, or SharePoint library or list.  

• In the Data Connection box, click Periods.  

• Click the Select XPath button next to the Entries box.  

• In the Select a Field or Group dialog box, click the Period group.  

• Click OK.  

• Click the Select XPath button next to the Display name box.  

• In the Select a Field or Group dialog box, click the Name field.  

• Click OK. 

Test the Form 
• On the Standard toolbar, click Preview Form.  

• In the Period box, click January 2004.  

• Click Retrieve My Sales. The form is filled with sales data. 

• In the Period box, click February 2004.  

• Click Retrieve my Sales. The form is filled with a different set of sales data. 

• Select Close Preview. 

Notes 
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Exercise 3: Submit a Form to a Web Service  
Now that the form can receive data from a Web service and an XML document, you can 
set up a data connection to submit data back to a Web service. 

Let Users Submit to a Web Service 
• Select Tools | Submitting Forms.  

• In the Submitting Forms dialog box, select Enable Submit commands and 
buttons.  

• In the Submit to list, click Web service.  

• Click Add to add a Web service submit data connection.  

• In the Data Connection Wizard, in the Enter the location of the Web service you 
want to use as your data connection box, type 
“http://fabrikam1:8080/FabriKamWS/bpr23ws.asmx”. 

• Click Next.  

• On the next page of the wizard, click SubmitSalesReport. 

• Click Next.  

The next page of the wizard allows you to map the parameters of the Web service to parts 
of the form. In this scenario, you want to submit all of the data of the Sales Report, so you 
select the salesReport group as salesReport parameter of the SubmitSalesReport Web 
service method.  

• Click the salesReport parameter in the Parameters list.  

• Click the Select XPath button shown bordered in red in Figure 3. 

 
Figure 31. Parameter Options dialog box. 

• In the Select a Field or Group dialog box, select the ns3:salesReport group 
(located several levels under the dataFields group, as shown in Figure 4).  

Notes 
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Figure 32. Navigate the tree to select the salesReport node. 

• Click OK.  

• In the Data Connection Wizard, select XML subtree, including selected element 
in the Include box. This sends the group, including all the groups and fields it 
contains, to the Web service.  

• Click Next.  

• In the next page of the wizard, click Finish.  

• Click OK to close the Submitting Forms dialog box. 

Test the Form 
• On the Standard toolbar, click Preview Form.  

• In the Period box, click January 2004.  

• Click Retrieve my Sales.  

• Make a change to the value in the form. For example, change product A to 
product X.  

• On the toolbar, click Submit.  

• In the Period box, click February 2004.  

Notes 
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• Click Retrieve my Sales.  

• In the Period box, click January 2004.  

• Click Retrieve my Sales. The change you made and submitted should be reflected 
in the new data from the Web service.  

• Click Close Preview. 
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Exercise 4: Dynamically Update a Form with Data from a Web 
Service 
This exercise shows you how you can use Web services and an OnAfterChange event to 
fill in the price of a product automatically when the name of the product is typed into the 
form.  

Add a New Data Connection for the GetPrice Web Service 
• Select Tools | Data Connections.  

• In the Data Connections dialog box, click Add.  

• In the Data Connection Wizard, select Receive data. 

• Click Next.  

• On the next page of the wizard, select Web service. 

• Click Next.  

• On the next page of the wizard, in the Enter the location of the Web service you 
want to use as your data connection box, type 
“http://fabrikam1:8080/FabriKamWS/bpr23ws.asmx”. 

• Click Next.  

• On the next page of the wizard, select GetProductPrice. 

• Click Next.  

• Click Next.  

• You only want to retrieve data when a change happens, so clear the Automatically 
retrieve data when form is opened check box. 

• Click Finish.  

• Click Close to close the Data Connections dialog box. 

Create an OnAfterChange Event 
• In the form, double-click the itemName text box, which is located in the Name 

column of the repeating table shown in Figure 5.  

 
Figure 33. itemName text box.  

• In the Text Box Properties dialog box, click the Data Validation button.  

• In the Data Validation dialog box, select OnAfterChange in the Events box.  

• Click Edit.  

Notes 

 

 

 

 

 Page 57 

http://msdn.microsoft.com/office/default.aspx?pull=/library/en-us/odc_ip2003_tr/html/odc_INF_Lab_08_05.gif


HOL: Building Solutions using Microsoft Office InfoPath 2003 
 

Notes 

 

 

 

 

 Page 58 

• In the code editor, replace the generated code in the OnAfterChange function with 
the following code.   

function msoxd_ns3_itemName::OnAfterChange(eventObj)  

{  

 // Don't update the price for undo/redo operations  

 if (eventObj.IsUndoRedo)  

 {  

  return;  

 }  

 // Don't update the price if it isn't a direct manipulation of the textvalue  

 if (eventObj.Site != eventObj.Source.parentNode)  

 {  

  return;  

 }  

 // Retrieve the GetProductPrice secondary data source  

 // (the DOM of the GetProductPrice Data Object)  

 var producPriceAuxDom = XDocument.DataObjects("GetProductPrice").DOM; 

 producPriceAuxDom.setProperty("SelectionNamespaces", 

  "xmlns:s0='http://tempuri.org/'");  

 // Find the productname in the secondary data source  

 var productNameAuxNode =  

  producPriceAuxDom.selectSingleNode("//s0:product");  

 // Set the value of the query parameter  

 productNameAuxNode.text = eventObj.Site.text;  

 // Query the Web Service, and place retrieved data in the  

 // secondary data source  

 XDocument.DataObjects("GetProductPrice").Query();  

 // Find the price in the secondary data source and the main data source  

 var priceAuxNode =  

  producPriceAuxDom.selectSingleNode("//s0:GetProductPriceResult");  

 var priceFormNode = eventObj.Site.selectSingleNode("../ns1:itemPrice");  

 // Update the main data source with the queried value;  

 priceFormNode.text = priceAuxNode.text;  

}  

 

NOTE: If you don’t want to type the procedure, open Windows Notepad and locate the file 
BPR23CodeSnippets.txt in C:\Microsoft Hands-On-Lab\HOL-BPR23\Source\Exercises. You can 
copy the procedure from that file and paste it to the Microsoft Script Editor. 
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• Close the code editor. If prompted, save the changes. 

• Click OK to close the Data Validation dialog box. 

• Click OK to close the Text Box Properties dialog box.  

Test the Form 
• On the toolbar, click Preview Form.  

• Select a period in the Period drop-down list.  

• Click Retrieve My Sales.  

• Type a different product name into the Name box of one of the rows of the table, 
and then tab out of the field (the Web service only supports product A through 
product F). Each time the field is changed, the onAfterChange event runs, and 
updates the Price field.  

• Click Close Preview. 

Note   The Source of the data modification is the salesReport node. The onAfterChange 
event handler does not modify the Price field, thanks to the following line in the code: 

if (eventObj.Site != eventObj.Source.parentNode)  

{  

 return;  

}  

• Click Close Preview. 
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Exercise 5: Create Custom Submit Processes 
This exercise shows you how to use a custom submit adapter to include business logic 
after submitting the form and still use the built in submit functionality. 

Add a New Data Connection for the GetPrice Web Service 
• Select Tools | Submitting Forms. 

• In the Submitting Forms dialog box, select Custom submit using form code in 
the Submit to list. 

• Click OK. The code editor opens with the cursor in the OnSubmitRequest function. 

• In the code editor, replace the generated code in the OnSubmitRequest function 
with the following code:  

function XDocument::OnSubmitRequest(eventObj)  

{  

 // Perform the built-in submit to a webservice  

 var submitAdapter = XDocument.DataAdapters("Main submit");  

 submitAdapter.Submit();  

 // Get and prepare the response of the Web service submit  

 var submitDom = submitAdapter.OutputLocation.ownerDocument;  

 submitDom.setProperty("SelectionNamespaces",  

  "xmlns:s0='http://tempuri.org/'");  

 // Find and display the response from the submit  

 var responseMessage =  

  submitDom.selectSingleNode("//s0:SubmitSalesReportResult").text  

 XDocument.UI.Alert(responseMessage);  

 // Tell InfoPath the submit was successful  

 eventObj.ReturnStatus = true;  

}  

NOTE: If you don’t want to type the procedure, open Windows Notepad and locate the file 
BPR23CodeSnippets.txt in C:\Microsoft Hands-On-Lab\HOL-BPR23\Source\Exercises. You can 
copy the procedure from that file and paste it to the Microsoft Script Editor. 

• Close the code editor. If prompted, make sure to save any changes.  

Test the Solution 
• On the toolbar, click Preview Form.  

• In the Period box, click January 2004.  

• Click Retrieve My Sales.  
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• On the toolbar, click Submit. You should see a message thanking you for 
submitting and the number of customers for whom you submitted an order.  

• Click OK to close the message box. You see another message box notifying you 
that the order has been submitted. 

• Click OK. 

• Click Close Preview. 

Add a Data Connection that Submits the Form in an E-mail Message 
In this step, you base your submit logic on whether the user is online or offline. 

• Select Tools | Data Connections.  

• In the Data Connections dialog box, click Add.  

• In the Data Connection Wizard, select Submit data. 

• Click Next.  

• On the next page of the wizard, click As an e-mail message, and then click Next.  

• On the next page of the wizard, type “LuisB@fabrikam.com” in the To box.  

• In the Subject box, do the following to combine the sales period with the text Sales 
Report:  

• Click the Formula button next to the Subject box.  

• In the Insert Formula dialog box, click Insert Function.  

• In the Insert Function dialog box, click Text in the Categories list, and then 
click concat in the Functions list.  

• Click OK.  

• Replace the first instance of the double-click to insert field text with the 
following (include the single quotes):  

'Sales Report: '  

• Double-click the second instance of the double-click to insert field text.  

• In the Select a Field or Group dialog box, select the period field several 
levels under the dataFields group, as shown in Figure 6. 
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Figure 34. Select the period element. 

• Click OK. 

• Delete the final instance of the double-click to insert field text. The Insert 
Formula dialog box looks like Figure 7. 

 
Figure 35. The formula concatenates static text with the value of the period field. 

• Click OK.  

• In the wizard, click Next.  

• On the next page of the wizard, in the Enter a name for this data connection box, 
type “E-mail submit”. 

• Click Finish.  

• Click Close to close the Data Connections dialog box. 

Notes 
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Update the Submit Code to Support Users who are Offline 
• Select Tools | Submitting Forms.  

• In the Submitting Forms dialog box, select Custom submit using form code in 
the Submit to drop-down. 

• Select the Edit Form Code check box. 

• Click OK.  

• Go to the OnSubmitRequest function that you created earlier in this module and 
copy the contents of that function into a new function called OnlineSubmit. The top 
line of the function should read as follows:  

function OnlineSubmit(eventObj)  

{  

 // Contents of OnSubmitRequest of Exercise two goes here.  

}  

• Paste the following code as a new function after the OnlineSubmit function:  
function OfflineSubmit (eventObj)  

{  

 // Perform the built-in submit to an email adapter  

 var submitAdapter = XDocument.DataAdapters("E-mail submit");  

 submitAdapter.Submit();  

 // Note that the following three lines should be a single line in MSE 

 XDocument.UI.Alert("You submitted your Sales Report offline. Your Sales 
Report has been put in your outbox and will be submitted as soon as you connect to 
the network.");  

 // Tell InfoPath the submit was successful  

 eventObj.ReturnStatus = true;  

} 

• Paste the following code in the body of the OnSubmitRequest function, replacing 
the old content you copied to the new OnlineSubmit function. The function should 
read as follows::  

function XDocument::OnSubmitRequest(eventObj)  

{  

 if (Application.MachineOnlineState == 1 /*xdOnline*/)  

 {  

  OnlineSubmit(eventObj);  

 }  

 else  

 {  

  OfflineSubmit(eventObj);  
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 }  

}  

 

NOTE: If you don’t want to type the procedure, open Windows Notepad and locate the file 
BPR23CodeSnippets.txt in C:\Microsoft Hands-On-Lab\HOL-BPR23\Source\Exercises. You can 
copy the procedure from that file and paste it to the Microsoft Script Editor. 

 

• Close the code editor. If prompted, make sure to save any changes.  

Test the Solution 
• On the toolbar, click Preview Form.  

• In the Period box, click January 2004.  

• Click Retrieve My Sales.  

• On the toolbar, click Submit. You should see a message thanking you for 
submitting and the number of customers for whom you submitted an order.  

• Click OK. 

• Click OK. 

• Navigate to Start | Internet.  

• In Internet Explorer, on the File menu, click Work offline to select it. 

• Return to InfoPath 2003. 

• Click Submit. You see the message shown in Figure 8. 

 
Figure 36. The message has been sent through Outlook 2003. 

Notes 
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• Click Send. You see a message that the form has been submitted offline.  

• Click OK. 

• Click OK. 

• Click Close Preview. 

• Close the form without saving changes. 

• In Internet Explorer, choose File | Work Offline to clear the Work Offline check 
box. 

• Select File | Close to close Internet Explorer. 

• Navigate to Start | Microsoft Office | Microsoft Office Outlook 2003. 

• Click Send and Receive. The e-mail with the submitted form appears in the Inbox.  

• Select File | Exit to close Outlook 2003. 

If you are continuing on to another module in this series after you complete this module, 
you do not need to shut down and restart the Virtual PC image. 
 

END OF MODULE 
 

(Additional reference material is at the end of this document.) 
 

If you are leaving the lab at this time, please press the RIGHT ALT and ENTER keys 
together to return the window to a restored state. 
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Module 4: Managed Code, Task Panes, Modifying Schemas, Digital 
Signatures 
In this module, you will learn how you can use the new features included in Microsoft® 
Office InfoPath™ 2003 SP 1 release to build advanced InfoPath 2003 solutions. You will 
learn advanced schema techniques, create custom task panes, implement business logic 
using managed code, and take advantage of enhanced support for embedded digital 
signatures. 

Estimated time to complete this module: 30 minutes 

Objectives 
After completing this module, you will be able to: 

• Create a custom task pane and add it to a form.  
• Create a form that responds to the OnContextChange event.  
• Update a task pane based on the form's state. 
• Add and debug business logic code with Visual Studio .NET 2003. 
• Set up .NET Framework Security for your InfoPath form. 
• Use roles in managed code. 
• Make data source changes using XML schemas. 
• Enable digital signatures for an entire form or part of a form. 
• Work with the InfoPath object model for digital signatures.  

Exercises 
 
• Use Managed Code to Add Business Logic to InfoPath 2003 Forms  

• Add a Custom Task Pane to an InfoPath 2003 Form 

• Work with Schemas in InfoPath 2003 

• Sign InfoPath 2003 Forms with Digital Signatures 

 
The sample files for this module may be found in the C:\Microsoft Hands-On-Lab\HOL-
BPR24\Source\Exercises folder.   
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Exercise 1: Use Managed Code to Add Business Logic to InfoPath 
2003 Forms 
The information technology (IT) department at FabriKam is investigating adding business 
logic written in managed code to their sales reports. They plan to utilize functionality 
provided by the Microsoft .NET Framework classes in a form, while continuing to use the 
built-in, form-specific features (data validation, conditional formatting) of InfoPath 2003.  

Using managed code business logic, InfoPath forms can call into the same InfoPath 2003 
Object Model (OM) that is available from script. In this exercise, you learn how to display a 
simple alert dialog box using the InfoPath 2003 OM. 

Before you can write managed code business logic in InfoPath 2003, you must create an 
InfoPath 2003 project in Visual Studio .NET 2003:  

Create an InfoPath Project in Visual Studio .NET 2003 
• Start Visual Studio .NET 2003.  

• Select File | New | Project.  

• Expand the Microsoft Office InfoPath Projects node. 

• Select Visual C# Projects.  

• In the Templates list, select InfoPath Form Template. 

• In the Name text box, type “InLab”.  

• Click the Browse button next to the Location text box. 

• Browse to C:\Microsoft Hands-On-Lab\HOL-BPR24\Source\Exercises\LabWork. 

• Click Open. The New Project dialog box looks like Figure 4. 

 
Figure 37. Add a new project for an InfoPath 2003 form. 

Notes 
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• Click OK.  

• In the Microsoft Office Project Wizard, make sure Create new form template is 
selected. 

• Click Finish. A new C# project, and a new InfoPath 2003 form, are created. 

Add an OnClick Event Handler 
Now that you have created an InfoPath 2003 project, you are ready to add event handlers. 

• In InfoPath 2003 Designer, from the Design Tasks task pane, click Controls.  

• In the Standard controls section, click the Button control to insert it into the view.  

• Double-click the button to open the Button Properties dialog box.  

• Change the Label field to “Alert”.  

• Change the ID field to “AlertID”.  

• Click Edit Form Code. Note that an OnClick event handler is added to the 
FormCode.cs file in Visual Studio.  

Add Form Code to the Event Handler 
You can now populate the event handler with managed code that runs whenever the button 
is clicked. 

• In the OnClick event handler, add the following code:  
 

thisXDocument.UI.Alert("Hello, World");  

 

Note that a Microsoft IntelliSense® window is displayed after each period (.) is typed, as 
shown in Figure 5. 
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Figure 38. Add form code to the event handler  

• Select Project | Preview | Default.  

• When the Preview window is displayed, click Alert.  

• Click OK to close the Hello, World message box. 

• Click Close Preview. 

Get the Current User's Username 
By using the .NET Framework classes, you can take advantage of functionality that was 
not easily available in script. In this example, you learn how use the .NET Framework 
classes to get the current user's username. 

Add an On Load Event 
• In Visual Studio .NET 2003, click the red dot indicating the breakpoint you set in the 

last step. Clicking this spot again toggles the breakpoint off. 

• Return to InfoPath 2003. 

• Select View | Data Source.  

• Right-click the myFields node. 

• Select Add.  

• In the Name field, type “employee”. 

• Click OK.  

• Drag the employee node into the view.  

Notes 
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http://msdn.microsoft.com/office/default.aspx?pull=/library/en-us/odc_ip2003_tr/html/odc_INF_Lab_15_02.gif
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• Select Tools | Programming | On Load Event. The code in this event handler is 
called each time the form is loaded.  

Add the Code 
• In the OnLoad event handler, type the following code:  

 

// store an XMLDOM node as a local variable  

IXMLDOMNode nodeEmployee = 

 thisXDocument.DOM.selectSingleNode("my:myFields/my:employee");  

if(nodeEmployee != null) 

   { 

       if(nodeEmployee.text == "") 

      { 

          // if the employee name is blank when we load the form, 

          // populate the employee node with the current user name  

         nodeEmployee.text = System.Environment.UserName;  

      }  

  }  

NOTE: If you don’t want to type the procedure, open Notepad and locate the file 
BPR24CodeSnippets.txt in C:\Microsoft Hands-On-Lab\HOL-BPR24\Source\Exercises. You can 
copy the procedure from that file and paste it to the Microsoft Script Editor. 

 

• Select Project | Preview | Default. The employee text box is populated with your 
username.  

• Click Close Preview. 

• Close Visual Studio .NET and InfoPath. 

Exercise 2: Add a Custom Task Pane to an InfoPath 2003 Form 
To reduce training costs, FabriKam wants to make it easier for its sales representatives to 
fill out their sales report forms. The information technology (IT) department must add a 
custom task pane to InfoPath 2003 to provide Help content to the sales representatives.  

Enable a Custom Task Pane 
The FabriKam user assistance editor has provided the IT department with an HTML file 
that contains the Help content for the custom task pane. An InfoPath 2003 custom task 
pane is an HTML file that is displayed in a task pane when the form is opened. In this 
exercise, you learn how to display the contents of an HTML file in a custom task pane. 
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• Navigate to Start | All Programs | Microsoft Office | Microsoft Office InfoPath 
2003.  

• In the Fill Out a Form dialog box, click Design a Form.  

• In the Design a Form task pane, click On My Computer.  

• In the Open in Design Mode dialog box, browse to C:\Microsoft Hands-On-
Lab\HOL-BPR24\Source\Exercises.  

• Select LabBPR24-TaskPane.xsn. 

• Click Open. The FabriKam sales report form opens in design mode.  

Enable a Custom Task Pane 
Now that you have opened your form in design mode, you are ready to create a custom 
task pane. 

• Select Tools | Form Options.  

• In the Form Options dialog box, click Advanced.  

• Select the Enable custom task pane check box. 

• Click Resource Files.  

• In the Resource Files dialog box, click Add.  

• In the File name box in the Add File dialog box, browse to C:\Microsoft Hands-On-
Lab\HOL-BPR24\Source\Exercises. 

• Select FabriKamSalesReportHelp.html. 

• Click OK twice.  

• In the Task pane location list on the Advanced tab, select 
FabriKamSalesReportHelp.html.  

• In the Task pane name box, type “FabriKam Sales Report Help”.  

• Click OK. 

Create Context-Sensitive Help 
The IT department has created the custom task pane. You need to add code that displays 
Help strings based on what the user has selected in the form when they are filling it out. In 
this step, you learn how to add the On Context Change event to the form, and add JScript 
code that displays Help strings by manipulating the task pane HTML file that you attached 
in the previous step. 
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• With the form still open, select Tools | Programming | On Context Change Event. 
The Microsoft Script Editor (MSE) starts, and the OnContextChange event is 
automatically inserted.  

• In the Microsoft Script Editor, find the code that looks like the following:  
function XDocument::OnContextChange(eventObj)  

    { 

        if (eventObj.Type == "ContextNode")     

            {  

                 // Selection or context in the form has changed. Write your code here to 
respond to the changes.  

                return; 

            } 

     }  

• Replace the code you found with the following code:  
function XDocument::OnContextChange(eventObj)  

    { 

        if (eventObj.Type == "ContextNode") 

            {        

                  // Retrieve task pane object 

                 var oTaskPane = XDocument.View.Window.TaskPanes.Item(0); 

                // Retrieve html object for task pane 

                var oHTMLDoc = oTaskPane.HTMLDocument.all; 

               // Clear previous help topic from task pane 

              if (helpString) 

                  oHTMLDoc.item(helpString).style.display="none";               

                // Display DIV statement having same ID as the context node name  

               oHTMLDoc.item(eventObj.Context.nodeName).style.display=""; 

               // Keep record of string displayed, so can later be cleared  

              helpString=eventObj.Context.nodeName; 

              return; 

              } 

     }  

NOTE: If you don’t want to type the procedure, open Notepad and locate the file 
BPR24CodeSnippets.txt in C:\Microsoft Hands-On-Lab\HOL-BPR24\Source\Exercises. You can 
copy the procedure from that file and paste it to the Microsoft Script Editor. 

• Add the following global variable definition before the OnContextChange event:  
//  

// Global variable to keep track of last help topic displayed,  
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// so that it can be cleared on context change and the  

// new topic will display alone.  

// 

var helpString = null;  

• Close the editor, saving changes when prompted.  

Preview the Form 
If you want to make sure that the changes work correctly and that they appear the way that 
you expect, preview the form. 

• In InfoPath 2003, on the Standard toolbar, click Preview Form. The form opens in 
a new window and the custom task pane you created appears.  

• In the preview window, click in the various fields (such as the Sales 
Representative and Customer Name fields) to check that the text in the task pane 
displays correctly. 

• Click Close Preview. 

• Close the form without saving changes. 
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Exercise 3: Schemas in InfoPath 2003 
FabriKam is using an InfoPath 2003 form built by its information technology department. 
However, the form needs to be incorporated into another process. To integrate the form 
with the existing process, you must modify the form's schema.  

Add and Move a Group in the Data Source 
The data source determines the structure of fields and groups that define and store data for 
an InfoPath 2003 form. In some cases, the fields or groups in the data source may not be 
compatible with the structure of the back-end process. In this scenario, the 
customerContainer group needs to be placed in another group named customerInfo.  

In this step, you add a group to the data source and then move that group to another group 
in the data source. 

• Navigate to Start | All Programs | Microsoft Office | Microsoft Office InfoPath 
2003.  

• In the Fill Out a Form dialog box, click Design a Form.  

• In the Design a Form task pane, click On My Computer.  

• In the Open in Design Mode dialog box, browse to C:\Microsoft Hands-On-
Lab\HOL-BPR24\Source\Exercises.  

• Select LabBPR24-Schema.xsn. 

• Click Open. The FabriKam sales report form opens in design mode.  

• Select View | Data Source.  

• In the Data Source task pane, in the Data source list, right-click myFields.  

• On the shortcut menu, click Add.  

• In the Add Field or Group dialog box, in the Name text box, type “customerInfo”.  

• In the Type list, select Group.  

• Click OK. 

Now that you have created the customerInfo group, you need to move it to the appropriate 
location in the data source. 

Move the Group to another Location  
• In the Data Source task pane, right-click customerContainer.  

• On the shortcut menu, select Move.  

• In the Move Field or Group dialog box, in the Select a new group list, select 
customerInfo.  
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• Click OK. 

• When prompted to continue, click Yes.  

Replace the Form's Schema 
To accommodate the back-end process, you discover that you need to make more 
changes to the schema then you expected. To save time, you can replace the form's entire 
schema with a schema that the developer who designed the back-end process has given 
you.  

• Select Tools | Convert Main Data Source.  

• In the Data Source Wizard, click Browse.  

• Browse to C:\Microsoft Hands-On-Lab\HOL-BPR24\Source\Exercises.  

• Select newschema.xsd.  

• Click Open. 

• Click Next.  

• When prompted to add an additional schema, select No. 

• Click Finish.  

Fields and groups from the new schema now appear in the Data Source task pane (the 
schemas are similar, but now the salesRepresentative, period, email, and department 
nodes are grouped under the reportHeader group). 

• Select File | Exit. 

• When prompted to save changes, click No. 
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Exercise 4: Sign InfoPath 2003 Forms with Digital Signatures 
The information technology (IT) department at FabriKam is tasked with adding support for 
digitally signing data in all forms. This ensures that information in InfoPath 2003 forms is 
not tampered with after sales representatives have completed the forms, and signifies the 
approval of the form. This support allows users to sign specific sections of the form, or the 
entire form.  

To sign InfoPath 2003 forms, users must have a digital certificate installed on their 
computer. Digital certificates can be requested from a certificate authority within the 
company's intranet or a commercial certificate authority.  

To be used with InfoPath 2003 forms, digital certificates must have a private key. The Key 
Usage for a certificate must be of type signature, or both signature and exchange (it cannot 
be only exchange) and the type of certificate must be Client Authentication, Code Signing, 
or E-mail Protection. Depending on the Certificate Authority, users can receive the 
certificate through an e-mail message, with the instruction on how to download (if 
necessary) and install it.  

Instead of requesting a digital certificate, you can create a self-signed certificate that is 
trusted on your machine. Such certificates, however, are not trusted on other computers, 
unless they are specifically added as trusted certificates. Therefore, this is not a 
recommended method of using digital signatures when deploying InfoPath 2003 forms.  

If a company has an internal certificate Web site, users can download and install 
certificates from that site. You will try out this type of certificate in this lab. This method will 
work for a built-in certification authority in Microsoft® Windows Server System™. 

Enable Support for Signing the Entire Form 
• Navigate to Start | All Programs | Microsoft Office | Microsoft Office InfoPath 

2003.  

• In the Fill Out a Form dialog box, click Design a Form.  

• In the Design a Form task pane, click On My Computer.  

• In the Open in Design Mode dialog box, browse to C:\Microsoft Hands-On-
Lab\HOL-BPR24\Source\Exercises.  

• Select LabBPR24-DigitalSig.xsn, and then click Open. The FabriKam sales report 
form opens in design mode.  

• Select Tools | Form Options.  

• In the Form Options dialog box, click the Digital Signatures tab. 

• Select Enable digital signatures for the entire form.  

• Click OK. 
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• Select File | Save As.  

• Click Save. 

• Browse to C:\Microsoft Hands-On-Lab\HOL-BPR24\Source\Exercises\LabWork. 

• In the File Name text box, type “SignEntireSalesReport.xsn”.  

• Click Save. 

Sign the Form 
Once you enable support for signing a form, you can add your signature. 

• On the File menu, click Fill Out a Form.  

• In the Fill Out a Form dialog box, under Open a form, click Open.  

• In the Open dialog box, locate the SignEntireSalesReport.xsn form that you just 
saved, and double-click the file to open it.  

• On the Standard toolbar, click the Digital Signatures button, highlighted in Figure 
1. 

 
Figure 39. The Digital Signatures button is on the Standard toolbar. 

• In the Digital Signatures dialog box, click Add.  

• In the Digital Signature Wizard, select Entire_form. 

• Click Next.  

• On the next page of the wizard, select the Luis Bonifaz certificate in the Select the 
certificate that you want to use to sign the form list. 

• Click Next.  

• On the next page of the wizard, type "I verified and approved all data that will be 
added with my signature" in the Comment text box. 

• Click Finish.  

• Review the content that you are about to sign, and then select the I have verified 
this content before signing check box. 

• Click Sign.  

• Click Close to close the Verify Digital Signature dialog box. 

• Click Close to close the Digital Signatures dialog box. 

Notes 
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The form is signed and users cannot change any data in it without invalidating the 
signature.  

• Move the cursor to the Sales Representative text box and try to type something. 
You won’t be able to add any data to the form because it has been signed. 

Note: You can add additional digital signatures to a form. Signatures beyond the first are 
treated as counter-signatures: The first signature signs the form and each subsequent 
signature signs the preceding signature. 

Remove the Signature 
• Click the Digital Signatures button on the Standard toolbar. 

• In the Digital Signatures dialog box, select the signature in the list. 

• Click Remove.  

• Click Yes. 

• Click Close to close the Digital Signatures dialog box. 

• Close the form without saving changes. You should still be in design mode with 
form SignEntireSalesReport.xsn. 

Note: If the form includes counter-signatures, you must remove the signatures in reverse 
order of the order they were added; the most recently added signature must be removed 
first.  

Prompt Users to Sign the Form on Submit 
In this step, you learn how to display a dialog box alert asking users to sign the form, when 
a form is submitted without a digital signature (this feature exists only for signatures that 
sign the entire form).  

• Select Tools | Form Options.  

• In the Form Options dialog box, click the Digital Signatures tab. 

• Select the Prompt user to sign the form if it is submitted without a signature 
check box.  

• In the Submitting Forms dialog box, click Enable Submit commands and 
buttons.  

• In the Submit to box, click Custom submit using form code. You specify a basic 
custom submit using the default submit event handler that only sets a value 
indicating that submit has succeeded.  

• Select the Edit Form Code check box. 

• Click OK.  
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• Remove the forward slashes (//) from the following line of code in the 
OnSubmitRequest function:  

// eventObj.ReturnStatus = true;  

The resulting line should look like this:  
eventObj.ReturnStatus = true;  

Note   This modification changes the line of code from a comment to executable code; the 
code allows you to click Submit and run the function without actually submitting the form. 

• Close Microsoft Script Editor, saving changes when prompted.  

• In the Form Options dialog box, click OK.  

• Click Preview Form on the Standard toolbar.  

• Click Submit. You receive the dialog box alert shown in Figure 2.  

 
Figure 40. You must sign the form before submitting it. 

• Click No. 

• Click OK to accept the submit notification. 

• Click Close Preview. 

• Select File | Close to close the form. You don’t need to save changes. 

Sign Parts of the Form 
In this step, you learn how to create a form that enables digital signatures for specific 
sections in the form. You also learn how to enable signature commands so that users can 
sign by clicking a command directly in the form.  

Enable Digital Signatures for Part of the Form 
Digital signatures can be enabled for the section or optional section that you want to sign 
from either the Form Options dialog box or the Section Properties dialog box. When the 
signatures are enabled through the Form Options dialog box, they can be associated with 
groups (that can be sections or not) or with standalone fields. 

• If the Design a form task pane is not displayed, select File | Design. 

• Choose LabBPR24-DigitalSig.xsn from the list in the task pane (it does not have 
any signatures defined).  

Notes 
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• Select Tools | Form Options.  

• In the Form Options dialog box, click the Digital Signatures tab. 

• Select Enable digital signatures for specific data in the form.  

• Click Add.  

• In the Set of Signable Data dialog box, type “MySignature1”.  

• Click the Select XPath button to the right of the Fields and groups to be signed 
box.  

• In the Select a Field or Group dialog box, expand signature1. 

• Select group1 (the group assigned to Customer information) 

• Click OK.  

• In the Set of Signable Data dialog box, under Signature options, select Allow 
only one signature.  

• In the Signature confirmation message box, type “I verified and approved all data 
that will be added with my signature”. 

• Click OK.  

• Click OK to close the Form Options dialog box. 

Enable Co-signatures within a Section  
In this step, you enable digital signatures for parts of a form using the Section Properties 
dialog box. You also assign a set of signable data with a signature starting from the same 
dialog box. The advantage to using this approach is that users can easily sign the form 
using commands directly in the form. 

• With the form still open, double-click the Section label at the bottom of the section 
in the form that contains the General comments box.  

• In the Section Properties dialog box, click the Digital Signatures tab. 

• Select the Allow users to digitally sign this section check box.  

• In the Sign the following data in the form when this section is signed drop-
down box, select Add data that can be signed.  

• In the Set of Signable Data dialog box, in the Type a name for the data that can 
be signed box, type “MySignature2”.  

• Under Signature options, click All the signatures are independent (co-sign). 

• Click OK.  

• In the Digital Signatures tab, the Show signatures in this section check box 
should be selected. When the check box is selected, all of the signatures added to 
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this section are displayed in a list below the section with the Click here to sign this 
section button. If this check box is not checked, only the Click here to sign this 
section button is displayed in the view.  

• Ensure that the When signed, make controls read-only check box is selected, so 
that all of the controls in the section are not editable when the section is signed. 

• Click OK to close the Section Properties dialog box.  

All co-signatures added to a set of signable data are independent, signing only the data. 

Enable Counter-signatures within a Section 
In addition to co-signatures, you can also enable counter-signatures for parts of a form. 
The first signature of counter type added to the data signs only the data, the rest of 
counter-signatures signs only the preceding signature. 

• With the form still open, select Tools | Form Options.  

• In the Form Options dialog box, click the Digital Signatures tab. 

• Ensure that Enable digital signatures for specific data in the form is selected.  

• In the Data in the form that can be signed list, select MySignature2. 

• Click Modify.  

• In the Set of Signable Data dialog box, under Signature options, select Each 
signature signs the preceding signatures (counter-sign).  

• Click OK. 

• Click OK. 

Associate an Existing Set of Signable Data with an Existing Section  
• With the form still open, double-click the Section label for the section in the form 

that contains Customer information.  

• In the Section Properties dialog box, click the Digital Signatures tab. 

• Select the Allow users to digitally sign this section check box.  

• In the Sign the following data in the form when this section is signed list, 
ensure that MySignature1 is selected. 

• Click Modify.  

• In the Set of Signable Data dialog box, select All the signatures are 
independent (co-sign). 

• Click OK.  
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• On the Digital Signatures tab, clear the When signed, make controls read-only 
check box. Controls in this section are editable, but the value of those controls 
cannot be changed while it is signed.  

• Click OK. 

• Select File | Save As. 

• Click the Save button. 

• Browse to C:\Microsoft Hands-On-Lab\HOL-BPR24\Source\Exercises\LabWork. 

• Type “PartSignSalesReport.xsn” in the File name text box.  

• Click Save. 

• Select File | Close to close the form. 

The form now contains two sets of signable data, both of which are associated with 
sections. One section can have multiple signatures that are independent of each other (co-
signatures), and the other section can have multiple signatures that sign each other 
(counter-signatures). Both display signatures directly in the form. Now users can sign 
sections of the form. 

Sign the Form  
• Select File | Fill Out a Form  

• In the Fill Out a Form dialog box, under Open a Form, click Open.  

• In the Open dialog box, browse to C:\Microsoft Hands-On-Lab\HOL-
BPR24\Source\Exercises\LabWork.  

• Select PartSignSalesReport. 

• Click Open. The FabriKam sales report form opens.  

• Under the Customer information section, click Click here to sign this section.  

• Select the Luis Bonifaz certificate. 

• Click Next. 

• Click Finish. 

• Select the I have verified this content before signing check box. 

• Click Sign. 

• Click Close. 

• Repeat the steps to sign the same set of data again.  

• Under the General comments section, click Click here to sign this section.  

• Select the Luis Bonifaz certificate. 
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• Click Next. 

• Click Finish. 

• Select the I have verified this content before signing check box. 

• Click Sign. 

• Click Close. The signature signs the MySignature2 set of data. 

• Repeat the steps to sign the same set of data two more times. The form looks 
similar to Figure 3. 

 
Figure 41. Two sections of the form have been signed, each more than once. 

The form now contains co-signatures (for the first set of signable data) and counter-
signatures (for the second set of signable data).  

Note: When signing parts of the form, signatures can be added also through the Digital 
Signatures dialog box, by selecting the specific set of signable data in the first page of the 
wizard. 

Notes 
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Remove Digital Signatures from a Signed Section in a Form 
In this step, you learn how to remove digital signatures from each set of data. 

• With the form still open, select Tools | Digital Signatures.  

• In the Digital Signatures dialog box, select the first signature added to the 
MySignature1 set of signable data. 

• Click Remove. Note that it can be removed because is a co-signature.  

• Select the first signature added to the MySignature2 set of signable data, and note 
that it cannot be removed because it is a counter-signature.  

• Select the third signature added to the MySignature2 set of signable data. 

• Click Remove. Note that it can be removed because it is the most recently added 
signature.  

• Click Yes. 

• Click Close. 

• Select File | Close. Don’t save changes. 

Work with the Digital Signature's Object Model 
In this step, you work with the digital signature's object model in InfoPath 2003 by creating 
a form that includes a task pane that displays all of the digital signatures in the form. 

Add a Task Pane for Digital Signatures 
• In the Fill Out a Form dialog box, click Design a Form.  

• In the Design a Form task pane, click On My Computer.  

• In the Open in Design Mode dialog box, browse to C:\Microsoft Hands-On-
Lab\HOL-BPR24\Source\Exercises\LabWork. 

• Select PartSignSalesReport.xsn. 

• Click Open. The FabriKam sales report form opens in design mode.  

• Select Tools | Form Options.  

• In the Form Options dialog box, click the Advanced tab. 

• Select the Enable custom task pane check box.  

• Click Resource Files.  

• In the Resource Files dialog box, click Add.  

• In the Add File dialog box, browse to C:\Microsoft Hands-On-Lab\HOL-
BPR24\Source\Exercises.  
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• Select DigSigTP.htm. 

• Click OK.  

• In the Resource Files dialog box, click Add.  

• In the Add File dialog box, select signatureerror.gif. 

• Click OK.  

• In the Resource Files dialog box, click Add.  

• In the Add File dialog box, select signaturevalid.gif. 

• Click OK.  

• Click OK to close the Resource Files dialog box. 

• In the Form Options dialog box, on the Advanced tab, in the Task pane name 
box, type “Digital Signatures”.  

• In the Task pane location box, select DigSigTP.htm.  

• Click OK. 

Inspect the Digital Signatures Object Model Code Sample (JScript) 
When you add the DigSigTP.htm file, you can use a text editor or code editor to open the 
DigSigTP.htm file so you can review the source code in the file. When the form is opened, 
the code in the DigSigTP.htm file searches for all of the signatures that are added to the 
sets of signable data in the form, and displays them in the task pane. Browsing the sets of 
signable data and displaying signature information is done using the signatures object 
model.  

Add Code to Update the Task Pane when Digital Signatures are Added or Removed 
• With the form still open, select View | Data Source.  

• In the Data Source task pane, double-click the signatures2 group (it should be the 
last group in the data source pane). 

• Click the Validation and Event Handlers tab.  

• In the Events box, select OnAfterChange. 

• Click Edit.  

• In Microsoft Script Editor, type the following code at the beginning of the 
OnAfterChange event handler:  

XDocument.View.Window.TaskPanes(0).Navigate("DigSigTP.htm");  

• Close Microsoft Script Editor. Save changes when prompted.  

• Click OK to close the Field or Group Properties dialog box. 
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Each time the signatures group is changed, this additional line in the onAfterChange 
event handler refreshes the information in the task pane that displays the digital signatures 
that are attached to the form. 

Edit the OnSign Event Handler 
• Select Tools | Programming | On Sign Event.  

NOTE: If you don’t want to type the code, open Notepad and locate the file BPR24CodeSnippets.txt 
in C:\Microsoft Hands-On-Lab\HOL-BPR24\Source\Exercises. You can copy the procedure from that 
file and paste it to the Microsoft Script Editor. 

• In Microsoft Script Editor, modify the OnSign event handler, find the line that looks 
like this: 

 

 var Signature=eventObj.SignedDataBlock.Signatures.Create();  

 

• Immediately after the line you found, add the following code: 
 

var nSig1 = 0, nSig2 = 0;  

for(var i=0; i<XDocument.SignedDataBlocks.Count; i++)  

    {  

         nSig1 = nSig1 + XDocument.SignedDataBlocks(i).Signatures.Count;  

    }  

 

• Find the line of code that looks like this: 
 

eventObj.ReturnStatus=true  

 

• After the line of code you found, add the following code:  
 

for(var i = 0; i<XDocument.SignedDataBlocks.Count; i++)  

    {     

        nSig2 = nSig2 + XDocument.SignedDataBlocks(i).Signatures.Count;  

    }  

    if(nSig1<nSig2)  

       {     

            XDocument.UI.Alert("Sign operation ended with success.");     

       }  

            else      
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      {  

            XDocument.UI.Alert("No signature was added.");  

      }  

• Close Microsoft Script Editor. Save changes when prompted.  

• Select File | Save As. 

• Browse to C:\Microsoft Hands-On-Lab\HOL-BPR24\Source\Exercises\LabWork.  

• Type “OMSignSalesReport.xsn” in the File name text box.  

• Click Save. 

Make a Form Fully Trusted 
In order for the OnSign event handler to run when the form is signed, the form must be 
fully trusted. There are two ways to create a fully trusted form:  

• Save the form and install it using the regform.exe tool.  
• Mark the form as fully trusted, and then sign it.  
In this step, you learn how to create a fully trusted form using the second method. 

• Select Tools | Form Options.  

• In the Form Options dialog box, click the Security tab.  

• Clear the Automatically determine security level based on form's design check 
box. 

• Select Full Trust.  

• Select the Sign this form check box. 

• Click Select Certificate.  

• In the Select a Certificate dialog box, select LabUserCertificate.  

Note: LabUserCertificate is a self-signed certificate that is trusted only on the computer 
where it was created. 

• Click OK. 

• Click OK. 

• Select File | Save.  

Test the Form 
• Select File | Fill Out a Form. 

• In the Fill Out a Form dialog box, under Open a form, click Open.  
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• In the Open dialog box, browse to C:\Microsoft Hands-On-Lab\HOL-
BPR24\Source\Exercises\LabWork. 

• Select “OMSignSalesReport”. 

• Click Open. The FabriKam sales report form opens in InfoPath 2003.  

• Select Tools | Digital Signatures, and verify that you can add a signature (that is, 
verify that the Add button is enabled). 

• Click Close.  

• In the form, click Click here to sign this section.  

• Select the Luis Bonifaz certificate. 

• Click Next. 

• Click Finish. 

• Select the I have verified this content before signing check box. 

• Click Sign. 

• Click Close.  

• Click OK. Note the new digital signature entry in the task pane. 

• Select Tools | Digital Signatures.  

• Select the last signature added. 

• Click Remove.  

• Click Yes. 

• Click Close. 

Note   Each time that a signature is added or removed from the form, the Digital 
Signatures task pane should update the list of signatures. 

• Close the form without saving changes. 

 

If you are continuing on to another module in this series after you complete this module, 
you do not need to shut down and restart the Virtual PC image. 

 
 

END OF MODULE 
 

(Additional reference material is at the end of this document.) 
If you are leaving the lab at this time, please press the RIGHT ALT and ENTER keys 

together to return the window to a restored state. 
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Additional References  
 
W3C (World Wide Web Consortium) http://www.w3.org
 
InfoPath Developer Center  
 http://msdn.com/infopath/  
 
InfoPath SDK and Reference Documentation 

http://msdn.microsoft.com/office/understanding/infopath/devdocs/default.aspx  
 
 
 

http://www.w3.org/
http://msdn.com/infopath/
http://msdn.microsoft.com/office/understanding/infopath/devdocs/default.aspx
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